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1. Introduction

The 3GPP Long Term Evolution (LTE) specifications present some new
challenges for manufacturers of components and equipment for LTE systems.
The standard is quite complex, with multiple channel bandwidths, different
transmission schemes for the downlink and uplink, both frequency and time
domain duplexing (FDD and TDD) transmission modes, and use of multiple-
input, multiple-output (MIMO) antenna techniques. LTE will co-exist with
current 2G and 3G cellular systems, so potential interference is an important
issue. All of this leads to high performance targets for LTE systems, and the
performance of the underlying components and devices will be a key factor in
whether those targets will be met.

Although the term “component test” is rather general, in this application note
the term refers to devices such as power amplifiers and RFICs for transmitters,
receivers, or transceivers. It does not include testing of base station (BS, also
referred to as enhanced node B or eNB) or user equipment (UE) transmitters or
receivers, since these topics are covered in other application notes from Agilent
Technologies. The focus is on stimulus-response testing using LTE signals and
measurements of transmitted signals from RFICs. Complete characterization of
such components may require a variety of additional measurements, including
testing using CW signals (e.g., S-parameters, gain compression, or intermodula-
tion distortion), noise figure, or power consumption, but those tests are beyond
the scope of this document.

This application note begins with a brief overview of the physical layer in the
LTE standards. Next it examines some of the testing requirements that apply

to components for LTE systems, using the LTE conformance tests as a starting
point, but focusing on the implications for testing components instead of eNBs
and UEs. An overview of measurement setups describes some of the equipment
and test solutions that are available from Agilent for LTE. This is followed by a
discussion on creating suitable LTE signals for component test and analyzing
transmitted signals from LTE components.



2. Brief Overview of the LTE Physical Layer

2.1 General characteristics

The physical layer for LTE utilizes orthogonal frequency division multiple access
(OFDMA) for the downlink, and single-carrier frequency division multiple access
(SC-FDMA) for the uplink. Both are multiple access technologies that allow
multiple users to transmit at the same time. Six different channel bandwidths
from 1.4 to 20 MHz may be used, with a fixed subcarrier spacing of 15 kHz,

or 7.5 kHz for multimedia broadcast multicast service (MBMS). As a result,

the number of OFDM subcarriers that is used changes for different channel
bandwidths.

2.2 Frame structures

One radio frame, T} = 3072007 = 10 ms

Y

One slot, 7, = 15360 x T = 0.5 ms
A S—

#0 #1 #2 #3 ceeesseees| #18 #19

»
< >

Subframe 0 Subframe 1 Subframe 9

1
1
One subframe !
1

Figure 1. LTE frame structure type 1 for FDD (TS 36.211)

There are two types of frame structures defined for LTE. Frame structure type
1 (FS1) is for FDD, while frame structure type 2 (FS2) is used for TDD. For both
types, one frame is 10 ms in duration, divided into ten subframes that are each
1 ms long, as shown in Figure 1. One subframe contains two slots, each with
0.5 ms duration. For FS1, the entire frame is used for either downlink or uplink
transmission.

For TDD, one 10 ms frame in FS2 consists of two half-frames that are each 5 ms
long, and each half-frame is divided into 5 subframes that are each 1 ms long,
as shown in Figure 2. Two switch-point periodicities are supported, 5 ms and 10 ms.
For frames with 5 ms switch-point periodicity, subframes 1 and 6 are special
subframes consisting of three fields: downlink pilot timeslot (DwPTS), guard
period (GP), and uplink pilot timeslot (UpPTS). Frames with 10 ms switch-point
periodicity have only subframe 1 as the special subframe; subframe 6 is a regular
downlink subframe. Table 1 shows the possible combinations of downlink and
uplink subframes that are defined in the LTE standard for TDD mode.
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Figure 2. LTE frame structure type 2 for TDD with 5 ms switch-point periodicity (TS 36.211)
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Table 1. TDD Uplink/downlink configurations (TS 36.211 Table 4.2-2)

2.3 Resource blocks

The smallest time-frequency unit used for transmission is called a resource
element, defined as one symbol on one subcarrier. A group of 12 contigu-

ous subcarriers over one slot in time forms a resource block (RB). and data
transmissions are allocated in units of RBs. The number of symbols in one RB
varies depending on the length of the cyclic prefix. For the normal cyclic prefix,
there are 7 symbols in one RB. For the extended cyclic prefix, there are 6
symbols when the subcarrier spacing is 15 kHz. In the downlink for multimedia
broadcast, there is also a case with extended cyclic prefix in which there are 3
symbols and a subcarrier spacing of 7.5 kHz.

Since the size of an RB is the same for all bandwidths, but the number of
subcarriers varies by bandwidth, the number of available physical RBs will be
dependent on the channel bandwidth as shown in Table 2. Note that the number
of used subcarriers shown in Table 2 applies for the normal subcarrier spacing
of 15 kHz.

Transmission bandwidth (MHz) 14 3 5 10 15 20
Number of used subcarriers 72 180 300 600 900 1200
Number of resource blocks per slot [ 15 25 50 75 100

Table 2. Number of subcarriers and resource blocks for different bandwidths



2.4 Physical signals and channels

The LTE air interface consists of physical signals and physical channels. Physical
signals are generated in Layer 1 and used for system synchronization, cell
identification, and radio channel estimation. Physical channels carry data from
higher layers including control, scheduling, and user payload. Table 3 provides

a summary of the physical signals. In the downlink, the primary and secondary
synchronization signals contain the cell identification, allowing the UE to identify
and synchronize with the network. In both the downlink and uplink there are ref-
erence signals (RS), known as pilot signals in other standards, which are used by
the receiver to estimate the amplitude and phase flatness of the received signal.

DL signals Full name Modulation sequence Purpose
P-SS Primary synchronization ~ One of 3 Zadoff-Chu sequences Used for cell search and identification by the UE.
signal Carries part of the cell ID (one of 3 orthogonal
sequences)
S-SS Secondary Two 31-bit BPSK M-sequences Used for cell search and identification by the UE.

synchronization signal

Carries the remainder of the cell ID (one of
168 binary sequences)

RS Reference signal (pilot) Complex I+jQ pseudo-random Used for downlink channel estimation.
sequence (length-31 Gold Exact sequence derived from cell ID, one of
sequence) 3 x 168 = 504 sequences

UL signals Full name Modulation sequence Purpose

DM-RS Demodulation reference  Zadoff-Chu Used for synchronization to the UE and UL

signal channel estimation

S-RS Sounding reference Based on Zadoff-Chu Used to monitor propagation conditions with UE

signal

Table 3. LTE physical signals



The physical channels carry the system information and user data. These are
summarized in Table 4. The different channels can result in frame structures that
are quite complex. For testing components, it is usually not necessary to create
signals that contain all of these physical channels.

DL channels Full name Modulation format Purpose
PBCH Physical broadcast channel QPSK Carries cell-specific information
PDCCH Physical downlink control QPSK Scheduling, ACK/NACK
channel
PDSCH Physical downlink shared QPSK, 16QAM, 640AM Payload
channel
PMCH Physical multicast channel QPSK, 16QAM, 640AM Payload for multimedia broadcast multicast service
(MBMS)
PCFICH Physical control format QPSK Carries information about the number of OFDM
indicator channel symbols (1, 2, 3 or 4) used for transmission of
PDCCHs in a subframe
PHICH Physical hybrid ARQ indicator BPSK modulated on 1 and Q  Carries the hybrid-ARQ ACK/NACK
channel with spreading factor 2 or 4
Walsh codes
UL channels Full name Modulation format Purpose
PRACH Physical random access Zadoff-Chu Call setup
channel
PUCCH Physical uplink control BPSK, QPSK Scheduling requests, ACK/NACK, Channel Quality
channel Indicator (CQl)
PUSCH Physical uplink shared QPSK, 16QAM, 640AM Payload, ACK/NACK, CQl
channel

Table 4. LTE physical channels

This brief overview of the physical layer covers some of the elements at a
relatively high level to provide a basic background. For further details, including
information about modulation and mapping to physical resources, please see the
literature references at the end of this application note.



3. Testing Requirements
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3.1 Amplifiers

The use of OFDMA for the downlink in LTE results in a signal that has a high
peak-to-average power ratio (PAPR) or crest factor, which is a result of the
independent phases of the multiple subcarriers adding constructively. The high
crest factor requires a large dynamic range for the power amplifier in the trans-
mitter, which is a challenge to provide while trying to optimize performance vs.
cost and complexity. SC-FDMA is used in the uplink to reduce the crest factor,
but amplifiers for UEs still need to deal with varying power levels.

Operating an amplifier in its nonlinear region results in gain compression or
clipping that causes distortion, leading to adjacent channel interference and
reduced spectral efficiency. Operating the amplifier with a back-off from its
compression point allows the amplifier to remain in its linear region and
minimizes distortion, but this comes at the cost of reduced efficiency.

An important task for the design engineer is to understand the performance

of the amplifier under different conditions and with input signals that have
different PAPR in order to determine the best trade-off within these constraints.
Tests that are typically used include power measurements, modulation quality
measurements such as error vector magnitude (EVM), and distortion measure-
ments such as adjacent channel leakage ratio (ACLR, also referred to as
adjacent channel power ratio or ACPR) and spectral regrowth.

3.2 Transmitter, receiver, and transceiver RFICs

A simplified high-level block diagram of the transmitter and receiver in an LTE
device is shown in Figure 3. The lower-level components in the transmitter or
receiver chain are determined by the type of architecture used in the design
(e.g., super-heterodyne vs. direct conversion) and may include additional
components such as filters or variable-gain amplifiers (VGAs). LTE includes the
use of MIMO technology, so LTE transmitters and receivers will include multiple
antennas, each connected to a transmit and receive chain, which are not shown
in Figure 3 for simplicity.
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Figure 3. Simplified high-level block diagram of transmitter and receiver
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RFICs may include different portions of this block diagram, with some contain-
ing either the transmitter or receiver only, or containing transceivers that
combine both transmitter and receiver in one component. Devices may also be
multi-band, with multiple output paths for each frequency band following the 1Q
modulator or multiple input paths going from the RF switch/multiplexer into the
1Q demodulator.

Traditionally most RFICs have used analog baseband 1Q inputs and outputs.
However, digital 1Q interfaces are becoming more common. The Mobile Industry
Processor Interface (MIPI) Alliance developed the DigRF v3.09 standard to
describe the digital baseband to RFIC interface for dual-mode 2.5G and 3G
devices, but this standard does not handle the complex nature of LTE signals
including high data rates and use of MIMO technology. The DigRF v4 standard is
now under development to address these requirements.

To see what measurements may be needed for characterizing these RFICs, it is
useful to consider the conformance tests that are required in the LTE standards.

3.3 Transmitter conformance tests from the LTE standards

The transmitter tests for the base station (eNB) are described in Section 6 of
3GPP TS 36.141. These tests are performed using specific configurations of
downlink signals that are known as E-UTRA Test Models (E-TM). Table 5 provides
a summary of the tests, the subsections in which they are described in the stan-
dard, and the test models that are used. It also includes the measurement in
the N9080A LTE FDD and N9082A LTE TDD applications for the Agilent X-Series
(PXA, MXA, EXA, and CXA) signal analyzers that can be used to perform these
tests. These applications and measurements are discussed in more detail later
in this application note.

Measurements on

TS 36.141 X-Series N9080A/82A LTE
section eNB transmitter test E-TM used measurement applications
6.2 Base station output power 1.1 Channel power
6.3 Output power dynamics
6.3.1 RE power control dynamic range 2,31,32,33 Modulation analysis
6.3.2 Total power dynamic range 2,31 Modulation analysis
6.4 Transmit ON/OFF power Note: This is for TDD only ~ Transmit On/Off power
6.4.1 Transmitter OFF power TBD (N9082A LTE TDD App)
6.4.2 Transmitter transient period TBD
6.5 Transmitted signal quality
6.5.1 Frequency error 2,31,32,33 Modulation analysis
6.5.2 Error vector magnitude (EVM) 2,3.1,32,33 Modulation analysis
6.5.3 Time alignment between transmitter branches 1.1 Modulation analysis
6.5.4 Downlink RS power 1.1 Modulation analysis
6.6 Unwanted emissions
6.6.1 Occupied bandwidth 1.1 Occupied BW
6.6.2 Adjacent channel leakage power ratio (ACLR) 1.1,1.2 Adjacent channel power
6.6.3 Operating band unwanted emissions 1.1,1.2 Spectrum emission mask
6.6.4 Transmitter spurious emissions 1.1 Spurious emissions
6.7 Transmitter intermodulation 1.1 Spectrum analyzer mode

Table 5. Base station transmitter conformance tests (TS 36.141 V8.5.0)



Transmitter tests for the UE are described in Section 6 of 3GPP TS 36.521-1.
Table 6 provides a summary of these tests, along with the measurements in
the X-Series LTE applications that can be used to perform the tests. Most of
these are similar to the eNB tests in Table 5, but there are a few tests that are
unique to the uplink, such as In-Band Emissions for Non-Allocated RB (6.5.2.3).
The uplink channel configurations used for these tests are called reference
measurement channels (RMCs).

TS 36.521-1 Measurements on X-Series N9080A/82A
section UE transmitter test LTE measurement applications
6.2 Transmit power
6.2.2 UE maximum output power Channel power
6.2.3 Maximum power reduction Channel power
6.2.4 Additional maximum power reduction Channel power
6.2.5 Configured UE transmitted output power Channel power
6.3 Output power dynamics
6.3.2 Minimum output power Channel power
6.3.3 Transmit OFF power Channel power
6.3.4 ON/OFF time mask N/A
6.3.5 Power control Channel power
6.5 Transmit signal quality
6.5.1 Frequency error Modulation analysis
6.5.2 Transmit modulation
6.5.2.1 Error vector magnitude (EVM) Modulation analysis
6.5.2.2 Carrier leakage Modulation analysis
6.5.2.3 In-band emissions for non-allocated RB Modulation analysis
6.5.2.4 Spectrum flatness Modulation analysis
6.6 Output RF spectrum emissions
6.6.1 Occupied bandwidth Occupied bandwidth
6.6.2 Out of band emission
6.6.2.1 Spectrum emission mask Spectrum emission mask
6.6.2.2 Additional spectrum emission mask Spectrum emission mask
6.6.2.3 Adjacent channel leakage power ratio (ACLR) Adjacent channel power
6.6.3 Spurious emissions
6.6.3.1 Transmitter spurious emissions Spurious emissions
6.6.3.2 Spurious emission band UE co-existence Spurious emissions
6.6.3.3 Additional spurious emissions Spurious emissions
6.7 Transmit intermodulation Spectrum analyzer mode

Table 6. UE transmitter conformance tests (TS 36.521-1 V8.4.0)

The tests in Tables 5 and 6 are intended for complete eNB or UE transmitters
with full baseband, RF, and protocol capabilities, so some of them may not be
applicable for component test. For testing amplifiers and RFICs, the main focus
is on examining the characteristics of the components that may impact the
quality of the transmitted RF signal—for example, errors in the 1Q modulator
such as 1Q offset or gain imbalance, 1Q timing misalignment, LO feedthrough,
phase noise, and EVM—as well as distortion characteristics such as ACLR and
spectral regrowth.
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3.4 Receiver conformance tests from the LTE Standards

Receiver tests for the eNB are described in Section 7 of 3GPP TS 36.141. Table 7
shows the list of these tests. These tests are performed using RMCs that define
the uplink test signals. A number of fixed reference channel (FRC) parameters
are defined for specific tests in Annex A of TS 36.141. For most receiver tests,
the required measurement described in the standard is the system performance
based on data throughput under specific conditions, so these tests are not very
suitable for components, which generally do not contain the receiver baseband
and software needed to obtain the throughput results. The one test that may

be applicable in some cases is the Receiver Spurious Emissions test, which
measures the emissions seen at a receiver port with the other ports terminated.
This test can be performed on a transceiver.

TS 36.141 section eNB receiver test

7.2 Receiver sensitivity level

7.3 Dynamic range

74 In-channel selectivity

15 Adjacent channel selectivity and narrow-band blocking
1.6 Blocking (in-band and out-of-band)

1.7 Receiver spurious emissions

7.8 Receiver intermodulation

Table 7. Base station receiver tests (TS 36.141 V8.5.0)

The UE receiver tests are described in Section 7 of 3GPP 36.521-1 and they are
listed in Table 8. Many of these tests are also not yet fully defined, but they
are similar in concept and objective to the tests for base station receivers. All
of these tests require measurements of the data throughput, so they are not
relevant for testing components.

TS 36.521-1 section UE receiver test

1.3 Reference sensitivity level

74 Max input level

75 Adjacent channel selectivity

1.6 Blocking characteristics (in-band and out-of-band)
1.7 Spurious response

1.8 Intermodulation characteristics

Table 8. UE receiver tests (TS 36.521-1 V8.4.0)

Instead of using these tests for receiver components, we can focus instead on
testing the demodulation quality and distortion characteristics for the lower-
level receiver components or the full receiver RF front end, depending on where
access is available to input test signals or measure signals.

1"



3.5 Measurements for component test

From the preceding discussion on test requirements, we can summarize the
measurements that may be of interest for LTE components in Table 9.

Measurement Amplifier test Tx/Rx RFIC test
Output power X

Frequency error X
Peak-to-average power (CCDF) X

Error vector magnitude (EVM) X X

1Q parameters X
(offset, gain imbalance, skew, quadrature error)

Adjacent channel leakage power ratio (ACLR), X X

also called adjacent channel power ratio (ACPR)

Spectrum emission mask X X
Spectrum flatness X X (UE Tx only)
In-band emissions for non-allocated RB X X (UE Tx only)
Spurious emissions X X

Table 9. Measurements for component test

Amplifier testing will require stimulus-response measurements in which a signal
generator is used to create an RF LTE signal that is input to the device-under-
test (DUT), and the output signal from the DUT is measured using a signal
analyzer.

Testing the transmitter chain will require using a digital or analog baseband
signal from the signal generator to drive the I/Q inputs and a signal analyzer to
measure the RF output. For the receiver path, an RF signal can be used to drive
the receiver, and the output of the low-noise amplifier (LNA) or 1/Q modulator
can be measured if access is available. The next sections will discuss measure-
ment setups and the creation and analysis of LTE signals.

12



4. Measurement Setups

A typical measurement setup for components that have RF inputs and outputs
is fairly simple, but testing a transmitter, receiver, or transceiver RFIC is more
complex. Figure 4 shows the RFIC block diagram from Figure 3, with some
possible setups that are available using Agilent’s test solutions for testing at
various points in the transmitter or receiver chains. A brief description of
these products is provided here. Updated information about these and other
Agilent products for LTE design and verification testing is available at
www.agilent.com/find/Ite.
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LTE application analysis software

Figure 4. Measurement setups for RFIC test
4.1 Downlink and uplink signal generation

Agilent’s Signal Studio software is a family of PC-based applications that
provide validated, performance-optimized signals in a variety of formats. The
N7624B Signal Studio for 3GPP LTE FDD and N7625B Signal Studio for 3GPP
LTE TDD provide coded physical layer LTE signals for both downlink and

uplink. The waveform files can be downloaded and played back in a variety of
Agilent instruments. Agilent’'s MXG and ESG signal generators can be used to
provide RF or analog I1Q signals. The MXG provides the industry’s best ACLR
performance for power amplifier testing. The ESG can also be used with the
N5102A digital signal interface module, which converts the digital IQ data to an
appropriate format for the device-under-test (DUT) and offers several breakout
boards to facilitate the physical connection to the device. Signal Studio can
also be used with Agilent’s 16800/16900 series logic analyzers and the N5343A
DigRF exerciser module, part of the Agilent RDX solution for DigRF, to create
digital 1Q signals.

13



b. Creating LTE Signals

4.2 Downlink and uplink signal analysis

Testing of complex LTE signals requires signal analysis with detailed modulation
analysis in addition to RF power measurements. Signal and spectrum analyzers
such as the Agilent X-Series (PXA, MXA, EXA, and CXA) and PSA can be used
to perform RF power measurements of LTE signals, and the MXA and PXA can
also measure analog 1Q signals.

The N9080A LTE FDD and N9082A LTE TDD measurement applications work
with Agilent PXA, MXA, and EXA signal analyzers to provide convenient
one-button power measurements, modulation analysis of downlink and uplink
signals, and programming control using SCPI commands.

Another analysis solution is the 89600 vector signal analysis (VSA) software,

a PC-based application that supports a wide variety of formats. Option BHD for
LTE FDD and Option BHE for LTE TDD provide comprehensive modulation and
MIMO signaling analysis based on current LTE standards, with additional flex-
ibility to go beyond one-button measurements. The VSA software works with
a variety of measurement instruments, including the X-Series and PSA signal
analyzers, oscilloscopes, logic analyzers, and the N5344A DigRF analyzer mod-
ule, part of the RDX solution for DigRF. The VSA's compatibility with multiple
instruments allows the same software to be used with different hardware for
testing at RF, analog 1Q, and digital 1Q interfaces in the block diagram. The VSA
also offers some features not available in the X-Series applications that can

be useful for troubleshooting, such as signal recording and playback, up to 6
simultaneous displays, spectrogram displays, and zooming on data displays.

One of the challenges of component test is deciding what type of test signal to
use. Ideally engineers want to test the performance of the components with a
variety of signals that reflect the range of conditions that the device may be
subject to in a real-world LTE system, including different PAPR or varying changes
in power from one symbol to another. Due to the complexity of the LTE standard,
there are practically endless possible configurations for a downlink or uplink signal,
with different channel bandwidths, physical control and data channels, modulation
types, number of RBs used, data content, etc. Trying to narrow down these choices
to a reasonable number of different test signals can be a daunting task.

Fortunately, the LTE standards define specific downlink and uplink test signals
that are used for conformance tests. These are good example signals to use for
component testing, although engineers may want to create additional signals
for more thorough testing.

5.1E-UTRA test models (downlink) for FDD

E-UTRA test models (E-TM) are defined in Section 6 of TS 36.141 for use in base
station transmitter testing, so these signals would be suitable for testing BS
power amplifiers or transmitter components. The test models to be used for each
conformance test were shown earlier in Table 5. The required physical channel
parameters for each E-TM are quite detailed; an example of these parameters for
E-TM1.2 is given in Table 10. Specific physical resource blocks (PRBs) may have
their power level boosted or de-boosted. The configurations for various control
and data channels are specified, along with their relative power levels.

14



Parameter 1.4 MHz 3 MHz 5 MHz 10 MHz 15 MHz 20 MHz

Reference, synchronization signals

RS boosting, P, = E,/E, 1 1 1 1 1 1
Synchronisation signal EPRE/E  [dB] 0.000 —4.730 —4.730 —4.730 —4.730 —4.730
Reserved EPRE/E  [dB] -inf -inf -inf -inf -inf -inf
PBCH

PBCH EPRE/E, [dB] 0.000 —4.730 —4.730 -4.730 -4.730 —4.730
Reserved EPRE/E [dB] -inf -inf -inf -inf -inf -inf
PCFICH

# of symbols used for control channels 2 1 1 1 1 1
PCFICH EPRE/E,, [dB] 3.222 0 0 0 0 0
PHICH

# of PHICH groups 1 1 1 2 2 3

# of PHICH per group 2 2 2 2 2 2
PHICH BPSK symbol power /E ; [dB] -3.010 -3.010 -3.010 -3.010 -3.010 -3.010
PHICH group EPRE/E,; [dB] 0 0 0 0 0 0
PDCCH

# of available REGs 23 23 43 90 140 187
# of PDCCH 2 2 2 5 7 10
# of CCEs per PDCCH 1 1 2 2 2 2

# of REGs per CCE 9 9 9 9 9 9

# of REGs allocated to PDCCH 18 18 36 90 126 180
# of dummy REGs added for padding 5 5 7 0 14 7
PDCCH REG EPRE/E, [dB] 0.792 2.290 1.880 1.065 1.488 1.195
<NIL> REG EPRE/E; [dB] -inf -inf -inf -inf -inf -inf
PDSCH

# of QPSK PDSCH PRBs which are boosted 2 6 10 20 30 40
PRB P, =E,/E, [dB] 3(9 3 3 3 3 3
# of QPSK PDSCH PRBs which are de-boosted 4 9 15 30 45 60
PRB P, =E,/E. [dB] —-2.990 (%) —4.730 -4.730 -4.730 —-4.730 —-4.730

Table 10. Physical channel parameters for E-TM1.2 (Table 6.1.1.2-1 from 3GPP TS 36.141 V8.5.0)

Creating these complex signals can be quite challenging. Fortunately, these test
models are provided as preconfigured selections in Agilent’s signal creation
software, including the N7624B Signal Studio for 3GPP LTE FDD and N7625B
Signal Studio for 3GPP LTE TDD. The test models are available for the “basic”
carriers and may be selected by choosing the “eNB Setup” page for FDD or
“Downlink” setup page for TDD and clicking on the Wizard button at the top.
For example, Figure 5 shows the frame structure for E-TM 1.2 for a 5 MHz
bandwidth from the N7624B Signal Studio software, which corresponds to the
parameters described in Table 10. E-TM 1.2 contains the P-SS, S-SS, and RS
signals for synchronization and channel estimation, plus most of the physical
channels. All of the available PDSCH RBs are modulated with QPSK. Two sepa-
rate PDSCH are defined to allow the power in some of the RBs to be boosted
while others are de-boosted.
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Figure 5. Frame structure for E-TM1.2 for a 5 MHz bandwidth

A review of the physical channel parameter tables for each of the E-TMs shows
the main ways in which they differ:

» Power or energy per resource element (EPRE) for various physical signals and
channels (e.g., PBCH or PCFICH) relative to the EPRE for the RS resource

elements (E)

* Number of resource element groups (REGs) allocated to the PDCCH
(one REG = 4 resource elements) and definition of the PDCCH

* Power boosting or de-boosting of PDSCH physical resource blocks (PRBs)
* Number of PRBs boosted or de-boosted
+ Amount of power boosting or de-boosting
» Which PRBs (by number) are boosted or de-boosted in each subframe

» PDSCH definition for EVM measurements

* Number of PRBs with a specific modulation type within a slot for
which EVM is measured

* Number and modulation type for PRBs within a slot for which EVM is
not measured (used for power balancing only), or number of PRBs that
are not allocated

* Ratio of the EPRE for PDSCH resource elements in symbols without
RS to E,
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As a result of these differences, the E-TMs have somewhat different spectrum and
power characteristics. In particular, E-TM2 has a high PAPR compared to the other
E-TMs because only one PDSCH PRB is allocated per slot and there is no power in
the other PRBs (except for the RS). In the other E-TMs, all of the PRBs are allocated,
although the power levels may be different for different PDSCH. High PAPR can

be seen by examining the complementary cumulative distribution function (CCDF)
of the signal, which is a statistical description of the percentage of time that the
signal is at or above a given power above the average power level. The calculated
CCDF can be displayed in the Signal Studio software after a signal is generated, or
the actual CCDF can be measured on a signal analyzer using Agilent’s 89600 VSA
software or the N9080A LTE FDD or N9082A LTE TDD measurement applications
for the X-Series signal analyzers. Figure 6 compares the calculated CCDFs from
Signal Studio for the 5 MHz bandwidth E-TM1.1 and E-TM2.

CCDF |Waveform‘ CCOF lWaveform}
BE Gaussian [ Reference  [@0Acquirs Ref. BuistCCDF~ ~ | Bf Gaussian B8 Reference  f1Acquie Ref. 8 Burst CCDF

20.00 dB

Figure 6. Calculated CCDF curves for E-TM1.1 (left) and E-TM2 (right)

The displays in Figure 6 show the CCDF of the signal in the yellow trace with the
CCDF for Gaussian noise as a reference in the blue trace. The x-axis is the power
relative to the average power level in the signal. From the display on the left, we
can see that the 0.01% CCDF value for E-TM1.1 is 9.52 dB. This value indicates
that the signal power exceeds the average power by at least 9.52 dB for 0.01% of
the time, or conversely, the signal power is less than 9.52 dB above the average
99.99% of the time. For the E-TM2 signal on the right, the 0.01% CCDF value is
14.34 dB. At every percentage on the y-axis, the E-TM2 signal has a higher peak-
to-average value on the x-axis than the E-TM1.1 signal. This signal would be much
more stressful for a power amplifier than the E-TM1.1 signal. The other E-TM
signals have CCDF characteristics that are much more similar to E-TM1.1, with
calculated 0.01% CCDF values ranging from 9.38 to 9.88 dB.

The spectrum and time-domain displays of the test model signals also show some
other differences. For example, Figure 7 shows the spectrum and time-domain
measurement over a period of 10 ms (1 frame) for the 5 MHz E-TM3.1 signal. Note
that the signal power is very uniform both in frequency and time. Figure 8 shows
the same measurements for the 5 MHz E-TM2 signal. There is clearly far more
variation in power vs. both frequency and time. Figure 9 shows the frame configu-
ration for E-TM2, which explains why these variations are present. The dominant
light colored background area represents the unallocated PDSCH resource blocks
that contain no power. The pink blocks that span two slots (1 subframe) are the
allocated PDSCH resource blocks that contain data with 64QAM modulation. The
symbols that contain the RS are indicated by the columns of short red lines. The
first and sixth subframes contain the P-SS and S-SS, and the first subframe also
contains the PBCH. Comparing this frame configuration with the power vs. time
configuration in Figure 8 shows clearly that the higher power symbols correspond
to the symbols that contain more allocated RBs.
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Figure 7. Spectrum and power vs. time for 5 MHz E-TM3.1 signal
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Figure 9. Frame configuration for 5 MHz E-TM2 signal
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5.2 E-UTRA test models (downlink) for TDD

For TDD, the test models are based on uplink/downlink configuration 3
(see Table 1) and special subframe configuration 8 defined in TS 36.211.
The test models have the following key characteristics:

* Downlink-to-uplink switch-point periodicity: 10 ms

* Number of UL/DL subframes per half-frame (10 ms): 6 DL, 3 UL
DwPTS: 24144 * Ts (Ts = 32.55 ns)

* Guard period: 2192 * Ts

+ UpPTS: 4384 * Ts

The test models are similar to the test models defined for FDD, but the RB
allocation is slightly different. Two frames are defined for the test models in
TDD, while only one frame is defined for FDD.

Figure 10 shows the spectrum and power vs. time for a 5 MHz E-TM2 TDD
signal, and Figure 11 shows the corresponding frame configuration. Only one of
the two frames is shown to make the details easier to see.
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Figure 10. Spectrum and power vs. time for 5 MHz E-TMZ2 TDD signal

Figure 11. Frame configuration for 5 MHz E-TMZ2 TDD signal
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When a component (especially a power amplifier) is tested with a TDD signal,
it may be necessary to synchronize the timing of the input test signal with the
measurement of the output signal and with turning the DUT on and off. For
example, when the CCDF is measured, it is important to limit the measurement
time to the period during which the RF signal is on. Measuring the power for
CCDF when the RF burst is off will change the average power value and hence
the peak-to-average results. In the case of the E-TM2 signal shown in Figure
10, the calculated 0.01% CCDF value from the N7625B Signal Studio software
is 13.82 dB for the RF burst only, but when the entire waveform is included, the
value is 15.50 dB. Waveform files created using Agilent’s Signal Studio software
include a marker output signal at the start of the frame that can be used to
trigger other instruments in the test system to aid with synchronization.

5.3 Uplink test signals

There are multiple uplink signals defined in the various standards documents
that could potentially be used as test signals for UE power amplifier or transmit-
ter components, or for the BS receiver components.

3GPP TS 36.141 defines uplink signals that are used for testing a BS receiver.
These are referred to as reference measurement channels (RMCs). The specific
configuration for a particular bandwidth and test is given as a fixed reference
channels (FRC) in Annex A. Table 11 shows an example of the FRCs used for
performance testing of the BS receiver with QPSK 1/3 modulation and coding.
The possibility of using variable reference channels (VRCs) for testing adaptive
modulation and coding (AMC) in UMTS was once discussed but never imple-
mented. At this time, the FRC is the only type of RMC defined for LTE, and the
terms FRC and RMC are sometimes used interchangeably.

Reference channel A3-1 A3-2 A3-3 A34 A35 A36 A37
Allocated resource blocks 1 6 15 25 50 75 100
DFT-OFDM symbols per sub-frame 12 12 12 12 12 12 12
Modulation QPSK QPSK  QPSK  QPSK  QPSK  QPSK  QPSK
Code rate 1/3 1/3 1/3 1/3 1/3 1/3 1/3
Payload size (bits) 104 600 1544 2216 5160 6712 10296
Transport block CRC (bits) 24 24 24 24 24 24 24
Code block CRC size (bits) 0 0 0 0 0 24 24
Number of code blocks - C 1 1 1 1 1 2 2
Coded block size including 12 bits trellis 396 1844 4716 6732 15564 10188 15564
termination (bits)

Total number of bits per sub-frame 288 1728 4320 7200 14400 21600 28800
Total symbols per sub-frame 144 864 2160 3600 7200 10800 14400

Table 11. FRCs for performance requirements with QPSK 1/3 (Table A.3-1, TS 36.141 V8.5.0)
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Table 11 covers the cases of a single RB allocation for A3-1 and full RB allocation
(in which all available RBs are used) for the various bandwidths in A3-2 through
A3-7. As an example of where these FRCs are used, we will consider the test
“Performance requirements for PUSCH" in Section 8.2 of TS 36.141. For a 5 MHz
bandwidth, Table 8.2.1.5-3 in TS 36.141 shows that depending on the propagation
(fading) conditions, FRC A3-1 or A3-4 may be used to test the BS receiver.

3GPP TS 36.521-1 Annex A.2 defines the RMCs for uplink signals used in UE
transmitter testing. Some RMCs are defined for full RB allocation and others for
partial RB allocation. For example, Table 12 shows the reference channels for
QPSK with full RB allocation.

Parameter Unit Value

Channel bandwidth MHz 1.4 3 5 10 15 20
Allocated resource blocks 6 15 25 50 75 100
DFT-OFDM symbols per sub-frame 12 12 12 12 12 12

Modulation

QPSK  QPSK ~ QPSK ~ QPSK  QPSK  QPSK

Target coding rate

1/3 1/3 1/3 1/3 1/5 1/6

Payload size Bits 600 1544 2216 5160 4392 4584
Transport block CRC Bits 24 24 24 24 24 24
Number of code blocks - C 1 1 1 1 1 1
Code block CRC size Bits 0 0 0 0 0 0
Total number of bits per sub-frame Bits 1728 4320 7200 14400 21600 28800
Total symbols per sub-frame 864 2160 3600 7200 10800 14400

Table 12. Reference channels for QPSK with full RB allocation (Table A.2.2.1.1-1, TS 36.521-1 V8.4.0)

Section A.2.2.2 in TS 36.521-1 defines the FDD reference channels for partial RB
allocation for each bandwidth with different modulation types. For a 5 MHz QPSK
signal, reference channels are defined with 1, 8, or 20 allocated RBs.

Similar reference channels are defined for TDD, assuming uplink-downlink allo-
cation configuration 1 (see Table 1) and a DL/UL configuration ratio of 2DL:2UL.
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Uplink signals with fully allocated RBs may make sense for some BS receiver
component tests, and Agilent’s Signal Studio software provides predefined
configurations for fully allocated signals for the basic uplink carriers. However,
in real-world situations a UE will often transmit only partially allocated signals
since the UE has to share resources with other UEs in the system. Therefore

in testing UE amplifiers or transmitter components, it may be useful to also do
some testing with a partially allocated uplink signal. In Signal Studio, the RMCs
with partial RB allocation are available as predefined configurations for the
advanced uplink carriers, since they are defined in the standards for BS receiver
test (in TS 36.141). Figure12 shows the spectrum, power vs. time, and frame
structure for a fully allocated 5 MHz uplink signal created with Signal Studio. As
one might expect, this signal is very uniform in power. The light gray areas in
the frame structure diagram are the allocated PUSCH, while the vertical orange
lines are the demodulation RS.
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Figure 12. Spectrum, power vs. time, and frame structure for a 5 MHz uplink signal with
25 allocated RBs (QPSK)
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Figure 13 shows the same information for a 5 MHz uplink signal with just one RB
allocated, as defined for FRC A3-1 (see Table A.3-1in TS 36.141). In this figure,
only RB 0 at the low end of the frequency band is allocated, and the spectrum
shows the signal power concentrated at those frequencies. Note that even though
no power is supposed to be in the other RBs, the spectrum does show that some
is present. For this reason the UE transmitter test of in-band emissions for non-
allocated RBs has been defined and will be discussed in more detail later.
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Figure 13. Spectrum, power vs. time, and frame structure for 5 MHz signal with
1 allocated RB (QPSK)
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It is also interesting to compare the CCDF characteristics of the uplink signal with
those of the downlink signal. Figure 14 shows the calculated CCDF for the 5 MHz
fully allocated QPSK uplink signal on the left (the CCDF for the signal in Figure 12 is
similar), compared to the CCDF for a fully allocated QPSK downlink signal (E-TM1.1)
on the right. The CCDF for the UL signal (yellow trace) shows much lower peak-
to-average power characteristics (e.g., the 0.01% value is 6.54 dB vs. 9.52 dB). The
lower PAPR allows the use of amplifiers with a smaller linear region in the UE,
which is why SC-FDMA was chosen for the UL instead of OFDMA.

CCDF | Wavefom | CCOF | wavefom |
B Goussian  EB Reference  [9Acquie Ref. B BustCCOF ~ B Gaussian B8 Reference  {@Acquire Ret. 58 Burst CCOF - ~

5.4 Transmission filtering

Unlike previous cellular communications standards such as cdma2000,
W-CDMA, or HSPA, the LTE standard does not define a specific transmission
filter. This allows various filter implementations, which may optimize either
in-channel performance, resulting in improved EVM, or out-of-band performance,
resulting in better ACPR and spectrum mask characteristics. There is a trade-off
between these characteristics, so optimizing one of them tends to make the
other one worse.

For testing components, it is desirable to start with a stimulus signal that

has the best possible performance for EVM or ACLR so that any degradation
caused by the DUT can be clearly determined. Agilent’s Signal Studio software
provides different options for filtering to allow users to modify the EVM and
ACPR characteristics of the signal. By default, the software turns on an Agilent-
defined baseband filter that provides a good balance between ACPR and EVM
performance. To optimize the signal for EVM performance, another type of filter-
ing can be applied by entering a non-zero value for the symbol rolloff length (in
units of Ts, where 1 Ts = 32.55 ns). This sets the length of the OFDM windowing
that is applied in the time domain to smooth out the discontinuities between
OFDM symbols. Increasing the value of this parameter can improve the EVM
performance, but it may degrade the ACPR performance.

The examples in the next few figures show results of using different types of
filtering. All use a 5 MHz E-TM 1.1 signal that fully allocates all available RBs
to the PDSCH using QPSK modulation. Figure 15 shows the results using the
default baseband filter. The composite EVM is about 0.53%, while the ACPR is
—73.2 dB.
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Figure 15. 5 MHz E-TM 1.1 signal with default baseband filter (best ACLR)

Figure 16 shows the results with the baseband filter turned off and the symbol
rolloff length set to 20Ts. This combination gives the best EVM, but the spectral
regrowth in the adjacent channel is quite high. The EVM is about 0.37% while
the ACPR is —43.1 dB.
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Figure 16. 5 MHz E-TM 1.1 signal without baseband filter and symbol rolloff length =
20 Ts (best EVM)
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Both types of filtering can be combined to give better EVM performance while
maintaining good ACLR. Figure 17 shows the results with the baseband filter
turned on and the symbol rolloff length set to 20 Ts. The EVM is 0.46% while the
ACPR is —73.1 dB.

AvglOff

e Trig: Free Run
Range: -2.00 dBm

Input: RF

25825
TimeLen 42 Sym

2583
Res BW 15 kHz

Span 7.68 MHz
Timel en 2.99998 ms

Res BW 1.27315 kHz

06:27:24 PMDex 10, 2009

03:01:45 PMDec 10, 2009
Trace FIEEES

Direction: Downlink

BW: 5 MHz(25 RB)

Center Freq: 2.135000000 GHz
AvglHold: 10110

Mech Atten 6 dB

Input: RF = Trig: Free Run
NCORR #Atten: 6 dB

Direstion: Downlink
BW: 5 MHz(25 RE)

IFGain:Low

" Stop 150 carrier
TimeLen 42 Sym

Carrier Power Filter

1 -12.01 dBm

Figure 17. 5 MHz E-TM 1.1 signal with baseband filter and symbol rolloff length = 20 Ts

The measurements in Figure 17 demonstrate the excellent ACLR performance of
Agilent’s MXG signal generators. A typical measurement of the E-TM 1.1 signal
from another vendor’s signal generator that has been optimized for best ACLR
performance is shown in Figure 18 for comparison. The setup is similar to what
was used for Figure 15 with the MXG. Note that the ACLR is —69 dBc compared
to about —73 dBc in Figure 15. Depending on the signal parameters, the MXG
typically has 3 to 5 dB better ACLR performance than signal generators from
other vendors with similar EVM performance, providing additional margin for
testing high-performance devices.
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Figure 18. 5 MHz E-TM 1.1 signal optimized for best ACLR from another vendor’s signal
generator
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5.5 Creating multi-carrier signals

Multi-carrier signals are useful for testing base station multi-carrier power
amplifiers (MCPAs) or for testing a device with both a desired signal and an
interfering signal. Since LTE systems are expected to co-exist with W-CDMA
systems, it is useful to be able to create test signals that include both types of
carriers. The N7624B Signal Studio for LTE FDD allows the user to create signals
containing up to 16 carriers, which may be LTE basic or advanced carriers, down-
link or uplink, or basic W-CDMA downlink or uplink carriers. This multi-carrier
capability provides a cost savings compared to other solutions that may require
the user to purchase separate applications to create the LTE and W-CDMA
carriers. Parameters such as frequency offset, power, timing offset, initial phase,
and filtering can be set for each carrier. For W-CDMA carriers, the filter setting
defaults to a root-raised-cosine Nyquist filter with a rolloff factor alpha = 0.22 as
specified in the 3GPP standards, although other filter types are available.

To create signals that combine LTE carriers with formats other than W-CDMA,
solutions are available that allow combining of either baseband signals or RF sig-
nals. Baseband combining can be accomplished with products such as Agilent’s
N5106A PXB baseband generator and channel emulator, which can play

back signals from up to six baseband generators and sum them, allowing the
combined signal to be upconverted to RF using a single signal generator. Each
baseband generator in the PXB can generate a signal from a different Signal
Studio application, with different frequency offsets and amplitudes. This solution
may be less expensive than an RF combining solution in which multiple signal
generators are used to create separate RF signals, which are then summed
together and applied to the DUT. However, the RF combining solution provides
better dynamic range between the desired and interfering signals, making it
more suitable for receiver testing applications.

5.6 Adding impairments

During the design phase, it may be useful to test components with signals that
contain specific impairments. Impairments can be used to stress test a device or
to simulate characteristics that may be added to a signal from other components
in the transmit or receive chain. Impairments can also be used to correct for
imperfections in the test signals.

Most signal generators allow the addition of various 1/Q impairments such as
I/Q offset, gain balance, quadrature angle, skew, and delay. Some instruments
such as Agilent’s N5162A and N5182A MXG RF vector signal generators also

allow the addition of phase noise impairments.
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6. Measurement and Analysis of LTE Signals

The main measurements for testing LTE components were listed earlier and
include the following:

* Qutput power

* Frequency error

* EVM

1Q parameters (offset, gain imbalance, skew, quadrature error)
* Peak-to-average power (CCDF)

ACRL or ACPR

* Spectrum emission mask

Spectrum flatness (uplink)

* In-band emissions for non-allocated RB (uplink)

* Spurious emissions

These measurements can be made using Agilent’s LTE FDD and LTE TDD
measurement applications for the X-Series signal analyzers (MXA/EXA), or
using 89600 VSA software with LTE FDD or LTE TDD modulation analysis.

The next sections will discuss each of these measurements in more detail. For
step-by-step instructions on how to perform these measurements using Signal
Studio and the MXA/EXA applications, please refer to the N9080A and N9082A
LTE Modulation Analysis Technical Overview with Self-Guided Demonstration
(literature number 5989-6537EN), which is available for download from the
Agilent Web site. The 89600 Vector Signal Analysis Software 3GPP LTE
Modulation Analysis Technical Overview and Self-Guided Demonstration
(literature number 5989-7698EN) is also available with instructions for the VSA
software.

6.1 Qutput power measurements

For this application note, output power measurements refer to channel power
and occupied bandwidth. Channel power indicates the mean power within the
appropriate integrated channel bandwidth. Occupied bandwidth measures the
bandwidth of the LTE signal that contains 99% of the channel power. Both of
these are available as one-button measurements in the N9080A and N9082A
applications for the Agilent X-Series signal analyzers, which have predefined
settings for all bandwidths of LTE signals. The measurements can also be
performed easily with the 89600 VSA software, using the band power marker
function for channel power and the occupied bandwidth marker function.

For the downlink, the conformance tests use E-TM 1.1 for these tests. For the
uplink, there are multiple conformance tests for output power using different
signal configurations, with partial and full RB allocations. The RMCs are
specified in Annex A.2 and the RB allocations are defined in several tables in
Sections 6.2 and 6.3 in TS 36.521-1.
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Note that for TDD signals, a time-gated measurement is necessary to ensure

that data is captured during the period when the burst power is on. The gated LO
function in the X-Series analyzers (under the [Sweep/Control] front-panel key) or
the time gate function in the VSA software should be used to define the measure-
ment period. The standard does not specify the time period for the measurement,
but typically it is performed during the period in which burst is completely on, not
including the ramp up or ramp down time. The waveform files created by Signal
Studio include a frame start marker (marker 1) that can be used as an external
trigger for the gating function. The signal from the EVENT 1 output of the signal
generator should be connected to the Trigger 1 IN connector on the rear panel of
the X-Series analyzer. Figure 19 shows the channel power measurement using an
MXA for a TDD signal with gate view turned on.
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Figure 19. LTE TDD channel power measurement with Gate View on

6.2 Frequency error, error vector magnitude, and
IQ parameters

Frequency error is the offset of the signal’s center frequency from the desired
center frequency and can be caused by problems in the transmit RF section
such as LO frequency error. EVM is a key test of modulation quality for a
transmitter and indicates the amount of distortion in the signal. 1Q error mea-
surements can reveal some of the possible sources for the distortion. The UE
transmitter conformance tests require the measurement of the carrier leakage
or 1Q origin offset, which can be an indicator of the carrier feedthrough or a DC
offset in the baseband signal (3GPP TS 36.521-1, Section 6.5.2.2).
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The frequency error, EVM, and IQ parameters are reported in the Error Summary
trace in the X-Series applications or VSA software, as shown in Figure 20. To
obtain the Error Summary results, the modulation analysis parameters need to
be set up properly to demodulate the LTE signal. This configuration includes
basic parameters such as channel bandwidth, DL or UL, channel profile, and
measurement time setup, as well as more advanced parameters such as the
equalizer settings and EVM window length. Both the X-Series applications and
the 89600 VSA provide convenient preconfigured setup files for EVM measure-
ments of the E-TM signals. These setups are accessed by following the steps
below.

*  X-Series applications

+ Start the LTE application: [Mode] > LTE

+ Select the Modulation Analysis measurement:
[Meas] > More > Modulation Analysis

* Recall the EVM setup file: [Recall] > Data > EVM Setup > Open.
Navigate to the folder My Documents\LTE\data\evmsetup if it is not
already open. Select the filename that matches the test model number
and channel bandwidth and click Open.

« 89600 VSA

 After the VSA software is started, go to File > Recall > Recall Setup

+ Navigate to the folder C:\Program Files\Agilent\89600 VSA\Help\
Signals\LTE\E-TM

+ Select the file matching the signal bandwidth and E-TM number and
click Open

+ The setup file assumes you are playing back a recording file, so you
may see an error message if an appropriate recording file does not
exist. Click OK to dismiss any error messages. Select Input > Data
From > Hardware and click on the Restart (play) button to start the

measurement.
+ Set the center frequency and range as needed for the LTE signal being
measured.
[ Chi Error Surmary Fange: 3162278 mv
E'hd = 51372 mXimz Iat E*twfindow End
Ehd Pl = 1o % oat sym 117, subcar 286
Data EVM = h15.88 miEms
- 2GPP-defined APSK EVM = -
- 3GPP-defined 1604AM EVM = --
- A5PP-defined 6404M BV = 51538 mimsz
RS Bk = A0557  mEmz
RS Tw Power [feeg] = 38222 dBm
OFDM Sprn, Tw. Power = -10.392 dBm
|| FregEx = 13683 mHz |
Synclor = 49554 % uzsing P-55
Cormmon Tracking Emor = 48055 miErms
SymClk Err = -0.00028 ppm
Timpe Offzet = 23449 L
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RS PRS = 3GPP

Figure 20. Error summary trace, including frequency error, EVM, and 10 errors
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6.3 Peak-to-average power ratio (PAPR) or CCDF

The concepts of PAPR and CCDF were discussed earlier. The X-Series LTE appli-
cations provide one-button CCDF measurements and the 89600 VSA also offers
CCDF measurements. For TDD signals, the measurement should be limited to a
time period in which the RF burst is turned on, since measuring the power dur-
ing the time when the burst is off will result in an incorrect average power value
and cause errors in the CCDF measurement. The frame start marker from the
EVENT 1 output in the ESG or MXG signal generator can be used as an external
trigger to the signal analyzer for the measurement. In the 89600, the measure-
ment time can be limited by changing the Main Time length or using time gating.
In the LTE TDD X-Series application, the user can select the CCDF measurement,
go to [Meas Setup], and set the [Meas Offset] and [Meas Interval] times to
specify the time span of the measurement. The slot view can also be turned on
to show the selected measurement interval by going to [View/Display] > Slot
View On, as shown in Figure 21.

Tl Agilent LTE TDD Beta - Power Stat CCDF E@@

Ea | SENSEINT] | ALIGNAUTO  [04:56:12PM Oct 13, 2009

Meas In Center Freq: 2.135000000 GHz TimeSlot: TS0
Input: RF o) Trig: Externall Counts:7.39 M10.0 MpDirection: Downlink

#IFGain:Low Atten: 12 dB (Elec 2) BW: § MHz2(25 RB)

Meas Setup

Counts
10.0 Mpt

Average Power

Meas Cycles
98.765

-10.52 dBm
36.86 % at 0dB

Meas Interval
6.7500 ms

Meas Offset
10.0 % 3.63 dB 5.0000 ms

10% 6.68 dB
0.1% 8.42 dB
0.01 % 9.47 dB
0.001% 10.21dB

0.0001 % 10.41 dB
Peak 10.41 dB

Figure 21. CCDF for downlink LTE TDD downlink signal
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6.4 Adjacent channel leakage power ratio (ACLR) or
adjacent channel power ratio (ACPR)

ACLR is a key transmitter characteristic and an important parameter to test

in power amplifiers, since power amplifiers are a key contributor of distortion
in the transmit chain. LTE systems have to co-exist with W-CDMA systems in
the same frequency bands, so the LTE RF conformance tests include cases in
which the adjacent channels can be either an E-UTRA (LTE) signal or a UTRA
(W-CDMA) signal. All E-UTRA channels are measured using a square filter
(essentially the same as no filter), while UTRA channels are measured using a
root-raised-cosine filter with a rolloff factor of 0.22 and a bandwidth equal to
the chip rate (e.g., 3.84 MHz). For base station (downlink) components, the tests
are performed using E-TM 1.1 in which all of the PDSCH RBs have the same
power, and with E-TM 1.2 in which power boosting and deboosting are used,
as previously described. For UE components, the uplink RMCs are specified in
Annex A.2 and the tests are performed with both full and partial RB allocation,
as defined in Table 6.6.2.3.4.1-1 in TS 36.521-1.

Setup of the ACLR measurement includes configuration of the carriers, offset
frequencies, integration bandwidths, resolution and video bandwidths, measure-
ment filters, and limit test. The X-Series LTE application provides a one-button
ACP measurement that greatly simplifies the setup process. Once the ACP
measurement is selected, the user can recall the appropriate parameters and
test limits from a list of available choices using these steps and keystrokes:

 [Recall] > Data > Mask > Open.

* Open the folder My Documents\LTE\data\masks.

* Choose either the ACP_BS folder or ACP_MS folder, depending on whether
you are testing a downlink or uplink signal. The folder contains files for each
signal bandwidth for paired or unpaired spectrum, Category A or Category

B limits (as defined in ITU-R SM.329), and type of carrier in the adjacent and
alternate channels: E-UTRA (LTE), UTRA (W-CDMA), or TD-SCDMA.

Open the appropriate file to recall the settings and limit lines. The correct
measurement filters will be selected based on the carrier types.

By default the limit lines are absolute limits and may appear above the top edge
of the graticule. To change them to relative limits, go to [Meas Setup] > Offset/
Limits > Limits > Fail Mask and select Relative. Note that these limits are
usually more lenient than what is desired from a component, since the limits
are intended for a complete BS or UE transmitter, so it may be useful to edit the
limits for component testing and save the setups.
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The quick setups will provide good ACLR measurements according to the LTE
standard, but the analyzer settings can be optimized to provide even better per-
formance. Methods for improving the ACLR measurement include the following:

1. Optimizing the signal level at the input mixer for dynamic range
2.Turning on noise correction
3.Changing the measurement method to use filtered integration bandwidth

To minimize clipping and prevent overload, the signal analyzer automatically
selects an attenuation value based on the current measured signal level at the
input mixer. A combination of mechanical and electronic attenuation may be
used in analyzers that contain both types of attenuators. This is not necessarily
the best attenuation for maximum dynamic range, and it is often possible to
improve the ACLR by reducing the attenuation slightly. If the electronic attenua-
tor is enabled, turning it off (not just setting the attenuation to 0 dB) can further
improve the results.

Turning on noise correction can provide a substantial improvement in the ACLR,
particularly when the distortion being measured is close to the noise floor of
the analyzer. With noise correction, the analyzer takes one sweep to measure
its internal noise floor, and then it subtracts that noise floor from the measure-
ment data in subsequent sweeps.

Finally, the measurement method can be changed. By default, the analyzer uses
the integration bandwidth method in which one sweep of the trace is taken and
the band power for each offset is computed. For maximum dynamic range, the
filtered integration bandwidth method can be chosen. With this method, a sharp
cutoff band pass filter is used to limit the resolution bandwidth. This technique
increases the dynamic range but also increases the measurement time. The
absolute accuracy of the carrier and adjacent or alternate channel power levels
may be degraded by up to 0.5 dB, but the ACLR measurement accuracy is not
degraded since it is a relative power measurement.

The combination of these optimization methods can improve a typical ACLR
measurement by 10 dB or more from the default settings.
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6.5 Spectrum emission mask

The spectrum emission mask (SEM) measurement covers the operating band
unwanted emissions tests from 3GPP TS 36.141 Section 6.6.3 for base stations
and TS 36.521-1 Section 6.6.2 for UEs. These tests measure the out-of-channel
emissions over a frequency span that includes the operating band plus one
channel above and one channel below the band edge frequencies.

Setup for the SEM measurement is much like the setup for ACLR and includes
configuration of the carrier, offset frequencies, integration bandwidths, resolu-
tion and video bandwidths, and test limits. As with ACLR, the X-Series LTE
application provides predefined limit masks for the SEM measurement, as well
as allowing manual configuration of the parameters. To access these masks,
use these keystrokes: [Recall] > Data > Mask > Open. Navigate to the folder
My Documents\LTE\data\masks. Choose either the SEM_BS folder or SEM_
MS folder, depending on whether you are testing a downlink or uplink signal.
The names of the files indicate the signal bandwidth, Category A or Category B
limits, below 1 GHz or above 1 GHz, limits for the additional requirements that
apply in certain regions, and limits for the additional requirements for bands 12,
13, 14, and 17. The default limit lines are absolute limits that assume the DUT
is transmitting at the maximum power as defined in the conformance tests, but
these limit lines can be changed to relative limits as described in the previous
section for ACLR. Figure 22 shows an example SEM measurement for a 10 MHz
E-TM 1.1 signal.

Similar to ACLR, the SEM limits are less strict than what is desired from a
component, so it may be necessary to edit the limit values to make them more
appropriate for component test.

1l Agilent LTE - Spectrum Emission Mask

X! ] A \ 05:42:45PM Oct 05, 2009
Elec Atten : 2.135000000 GHz
Input: RF B - Direction: Downlink
IFGain:Low BW: 5§ MHz(25 RB]

Figure 22. Spectrum emission mask measurement for 10 MHz E-TM 1.1 signal

34



6.6 Spectrum flatness (uplink)

EVM equalizer spectrum flatness is part of the transmit signal quality
conformance test for a UE transmitter (3GPP TS 36.521-1, Section 6.5.2.4). It

is a useful test in addition to EVM, because EVM measurements are typically
performed after the analyzer has estimated and removed the amplitude and
phase errors over frequency through the equalization process, as defined in the
standard. These errors may be overlooked if only EVM is considered. Spectrum
flatness measures the relative power variation across the subcarriers of the
allocated RB over one slot in the time domain, for 20 measurements in a frame.
The test is performed with a fully allocated uplink signal with QPSK modulation
for the RBs, so a test signal can be created using the default uplink carrier
configuration in the Signal Studio software, with the appropriate bandwidth and
QPSK modulation selected for the channel configuration.

The spectrum flatness measurement can be made by examining the equalizer
channel frequency response results that come from the equalization process.
This is one of the data types available in the 89600 VSA software and the modu-
lation analysis measurement in the X-Series application. Both applications also
provide a display that shows the equalizer channel frequency response per slot,
with each slot in a different color trace, as shown in Figure 23. The measure-
ment interval can be modified to focus on the result for a specific slot if desired.

.);;“_. Agilent 89600 Vector Signal Analyzer ‘;HEHXl
Elle Edit Control Spurce Input TestSetup MeasSetup Display Trace Markers Utiities Help
2 W‘ S |H®|E© ) () (B Singl= - H”T e |l M H] # 50% | Color Narmel - |
5 B: Ch1 OFDM Per Slot Eq Ch Freq Resp Range: -6 dBm

dB

Laoghdag

g i
| J“ K
|

a1
de

Start: 150 carier Stop: 149 carrier
REW: 15 kHz
Measurement paused | LTE | INTREF | AUTOCAL:OK |2 [F [E[ahe)

Figure 23. Per slot equalizer channel frequency response for a 5 MHz UL signal
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6.7 In-band emissions for non-allocated RB (uplink)

As previously discussed, it is normal for a UE to occupy only a portion of the
channel bandwidth, since the uplink channel is shared with other UEs. Figure 12
shows that there can be signal leakage within the channel bandwidth that can
cause interference with other UEs, and the in-band emissions for non-allocated
RB test is a measure of the amount of power that the UE may transmit into the
non-allocated RB. This test applies only to UE transmitters and components.
Although the test is not yet fully defined, sufficient information is available for
component testing.

The UL signal is configured using the RMC specified in Annex A.2 with partial RB
allocation in which the starting RB is defined to be RB #0 and RB# (max +1 — RB
allocation) for the channel bandwidth (see Table 6.5.2.3.4.1-1 in 3GPP TS 36.521-1).

There are three types of in-band emissions that are defined: general, IQ image,
and DC. General applies to any non-allocated frequencies. The measurement
bandwidth is one RB and the measurement is the ratio of the measured power
in one non-allocated RB to the measured average power per allocated RB, with
the averaging done across all allocated RBs. 1Q image applies to image frequencies
that are within the allocated bandwidth, based on symmetry with respect to the
center frequency, excluding any allocated RBs. The DC measurement applies to
the RB containing the center frequency when the number of available RBs is
odd, or the two RBs immediately adjacent to the center frequency if the number
of resource blocks is even, excluding any allocated RB. For DC, the measurement
bandwidth is one RB and the test limit is the ratio of the measured power in one
non-allocated RB to the measured total power in the applicable allocated RBs.

These measurements can be performed using the “RB Power Spectrum” data
display. This is one of the “Demod” data types in the 89600 VSA software, and
one of the “Demod Error” data trace types in the X-Series application. Relative
markers can be used to measure the ratio of power in the non-allocated vs.
allocated RBs. A detailed example of these measurements is given in the
demo guide for the X-Series application which can be downloaded from
www.agilent.com by using the document literature number “5989-6126EN" as
the search term.
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Figure 24 shows a measurement of a 5 MHz uplink signal using the X-Series
application. The signal has 8 allocated RBs with QPSK modulation as stipulated
in 3GPP TS 36.521-1 Table 6.5.2.3.4.1-1. There are 25 available RBs (numbered
RB #0 to RB #24), so the DC component would be included in the center RB
(#12). Figure 24 shows marker 1 displaying the power at RB #6 for slot 0, while
marker 2 shows the power at RB #18, which is the image of RB #6, since both
are the 6th RB away from the center. In addition to “Marker X,” which can be
set to a point in the x-axis (RB #), “Marker Z" can be used for the time axis to
select a specific slot to measure.

T Agilent LTE - Modulation Analysis
Lxi L s0Q A T AL T 01:40:52 PM_Oct 2008

Marker 2 X 18.00 RB ) !
Input: RF o Trig: Free Run Direction: Uplink

Range: -2.00 dBm BW: 5 MHz(25 RE)

Ch1 OFDM RB Power Spectrum Mkr2 O slot 18 RB Non-alloc
10 dB/div Ref 30 dB -56.028 dB -56.622 dB Avg

Start 0 RE Stop 24 RB
Res BW 13 kHz TimelLen 20 Slot

MKR MODE TRC A FUNCTION | FUNCTION w/IDTH FUNCTION YALUE
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Figure 24. RB power spectrum
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Summary

6.8 Spurious emissions

Spurious emissions can be caused by transmitter problems such as harmonics,
intermodulation products, and frequency conversion products in the power
amplifier or other transmit chain components. The conformance tests measure
these out-of-band emissions from 9 kHz to 12.75 GHz (excluding the frequency
range that is covered by the SEM test) to ensure protection of other radio
systems that may be operating in the same geographical area. The conformance
tests include the test limits that apply in various frequency ranges, along with
the measurement bandwidth to be used in each.

The spurious emission test is performed using the E-TM 1.1 signal for the
downlink. For the uplink, the test is performed with three configurations: full RB
allocation, one RB allocation located at RB #0, and one RB allocation located at
RB #maximum using the RMC defined in Annex A.2.2.

The X-Series application includes a spurious emission measurement that

identifies and measures the power level of spurious emissions in the 3GPP
defined frequency bands. The measurement allows you to set up a table of
frequency ranges with measurement bandwidths and filter types, spur threshold
values, and pass/fail limits. The application includes a default range table based
generally on the limits for Category B, but the frequencies and limits are not
specifically set up for particular LTE frequency bands. Also, the conformance
tests contain test limits for specific situations such as co-existence with other
systems such as GSM900, DCS1800, PCS1900, PHS, and public safety radio
systems, and these situations may not be applicable as they are dependent on
regional regulations and the operating band of the LTE equipment. Therefore,
the range table should be edited to include the applicable requirements. The
conformance test limits may be found in 3GPP TS 36.141 Section 6.6.4 for the
BS and 3GPP TS 36.521-1 Section 6.6.3 for the UE.

To improve the signal analyzer’s dynamic range for these measurements, the
input attenuation settings can be optimized under the [Amplitude] menu.

This application note covered testing requirements and considerations for LTE
components and provided information on test equipment setups, creating LTE
stimulus test signals for components, and analyzing LTE signals from compo-

nents and transmitters. Additional information about Agilent’s LTE solutions is
available online at www.agilent.com/find/Ite.

Free downloads and free trials are available for the Signal Studio software,
89600 VSA software, and the X-Series measurement applications. These
provide a good way to examine the capabilities of Agilent’s LTE products in
more detail and to explore and learn about the physical layer characteristics of
LTE. The demo guides for the 89600 VSA and the N9080A/N9082A X-Series LTE
measurement applications provide a comprehensive introduction to the features
in those applications.
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